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修订历史

版本 修改内容

V1.0.0 初次发布。
V1.1.0 ⽀持多设备；增加了时间戳；路径空间问题；路径缓冲区溢出等。
V1.2.0 增加⼯具指南章节；更新 2.4节 Cache解析。
V1.3.0 新增 4.4节 RISC-V Tool。
V1.4.0 新增 4.5节 EMI Tool；新增 4.6节 PA Configure Tool；新增 4.7节 EVK Offline Tool。
V1.5.0 新增 4.8节 Secure Boot Tool。
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1 简介
“Telink Burning and Debugging Tool (BDT)”适⽤于基于 Telink SoC（包括 8267、8269、8266、8232、8233、
8366、8368、B85M系列以及 B91M系列）的应⽤开发。
这份⽂档介绍了如何使⽤ “Telink Burning and Debugging Tool (BDT)”。

1.1 功能概述
在 SDK开发过程中，通过使⽤ “Telink Burning and Debugging Tool（BDT）”，可以通过 USB模式或者 “Burning
EVK”（EVK）将固件直接下载到⽬标板（例如开发板）。
它主要的功能包括：擦除 flash扇区，下载固件，通信失败时激活 MCU，访问包括 Flash/Core/Analog/OTP在
内的内存空间，读/写全局变量和查看 USB⽇志。

Figure 1.1:主界⾯

AN-18101201-C6 12 Ver1.5.0
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2 操作指南

2.1 下载固件
2.1.1 连接硬件

在使⽤ “Telink Burning and Debugging Tool (BDT)”之前，需要连接⽬标板和 PC。
有两种⽅法连接⽬标板和 PC，如下所⽰。
⽅法 1：通过 USB直接连接⽬标板和 PC。
这种⽅法只适⽤于具有 USB接⼝的⽬标板和⽀持 USB功能的 MCU，例如 dongle板。

Figure 2.1:直接将⽬标板与 PC连接

⽅法 2：通过 Telink “Burning EVK” TLSR8266BR56连接⽬标板和 PC。
（1）通过 USB线将 “Burning EVK”与 PC连接。观察 “Burning EVK”的指⽰灯，指⽰灯闪烁⼀次，表明 “Burning
EVK”与 PC连接成功。

AN-18101201-C6 13 Ver1.5.0
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Figure 2.2:将 “Burning EVK”与 PC连接

（2）连接 “Burning EVK”和⽬标板。
有两种⽅法连接 “Burning EVK”和⽬标板。

a. 通过 USB接⼝直接连接⽬标板和 “Burning EVK”，如下图所⽰。这种连接⽅式只适⽤于有 USB接⼝的⽬
标板和⽀持 USB功能的 MCU，如 dongle板。

AN-18101201-C6 14 Ver1.5.0
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Figure 2.3:通过 USB连接 “Burning EVK”和⽬标板

b. 通过 Swire（单线）接⼝连接 “Burning EVK”和⽬标板，如下图所⽰。
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Figure 2.4:通过 Swire连接 “Burning EVK”和⽬标板

有关 TLSR8266BR56 的详细信息，请参阅 Telink ⽂档 “AN_18010500_User Guide for Telink Burning EVK
TLSR8266BR56”。
通过 “USB” ⽅式或 “Burning EVK” ⽅式将⽬标板连接到 PC 后，有两种⽅法可以将固件下载到⽬标板上，分别
对应上述两种硬件连接⽅式。

2.1.2 连接设备

在将固件下载到⽬标板之前，请确保 BDT已找到该设备，如下图所⽰。
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Figure 2.5:烧录和调试⼯具

如果 BDT没有找到设备，如下图所⽰，可以点击 “Refresh”查看可⽤设备。
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Figure 2.6:查看可⽤设备

如果 BDT发现多个设备，所有设备将会列出，如下图所⽰。点击 “Refresh”按钮后，默认情况下第⼀个设备将
连接到 BDT。如果想要连接其他设备，可以选择指定的设备，如下图所⽰。
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Figure 2.7:选择指定的设备

2.1.3 通过 “USB”模式将固件下载到 “Flash”中

在使⽤ “USB”模式下载或调试 MCU之前，请确保指定的 MCU⽀持 USB功能，并且其 USB功能可⽤。详细信
息请参阅第 5章功能⽀持列表。
接下来，⽤⼾可以按照本章指南，通过 “USB”模式将固件下载到⽬标板的特定 flash空间。
步骤 1：选择⽬标板的芯⽚类型，例如 8258（默认选项），⽀持以下两种⽅法。

• ⽅法 1：使⽤下拉菜单选择芯⽚类型。
• ⽅法 2：按组合快捷键 “Ctrl+Q”切换芯⽚类型。

注意：
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所有芯⽚类型和默认选项都可以在 “config.ini”⽂件中配置。

Figure 2.8:选择芯⽚类型

步骤 2：选择下载模式为 “USB”，⽀持以下两种⽅法。

• ⽅法 1：使⽤下拉菜单选择 USB下载模式。
• ⽅法 2：按组合快捷键 “Ctrl+W”切换到 USB下载模式。每次切换后，下拉菜单将⾃动显⽰当前下载模式。

注意：
所有下载模式和默认选项都可以在 “config.ini”⽂件中配置。
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Figure 2.9:选择下载模式为 “USB”

步骤 3：点击 “Setting”按钮，打开设置对话窗⼝。选择 “Flash”选项。⽤⼾可以采⽤以下任意⼀种⽅法，设置
⽬标固件存储的 flash起始地址偏移量，例如 0x000000（默认选项）。

• ⽅法 1：使⽤ “Download Addr”的下拉菜单选择可⽤的偏移选项。
• ⽅法 2：在 “Download Addr”的编辑框中输⼊偏移地址。

注意：
• 所有设置和默认选项都可以在 “config.ini”⽂件中配置。
• ⽤⼾还可以配置 “SRAM”/“OTP”设置选项，以便将⽬标固件下载到 SRAM或 OTP中的⽬标区域。
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Figure 2.10:选择起始偏移地址

步骤 4：选择要下载到⽬标板的⽬标固件⽂件。
（1）点击 File->Open，打开⽂件选择窗⼝。
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Figure 2.11:打开⽂件选择窗⼝

（2）在⽂件选择窗⼝，选择⽬标 bin⽂件（如 Telink.bin），然后点击 “打开”按钮。
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Figure 2.12:选择⽬标⽂件并打开新的⽂件路径

⽂件路径将显⽰在主界⾯的底部。每次通过⽂件选择窗⼝打开新⽂件路径时，它都会被添加到 “File->Reopen”
的⼦菜单中。这样可以简化后续选择固件操作，⽤⼾可以直接选择 “Reopen”⼦菜单中可⽤的⽬标⽂件路径。

AN-18101201-C6 24 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

Figure 2.13:在 “Reopen”⼦菜单中直接选择⽬标⽂件路径

步骤 5：检查⽬标板和 PC之间的连接状态，确保其正常。

• 如果连接状态正常，主界⾯左下⻆将显⽰ “usb device: ok”或 “evk device: ok”。
• 如果主界⾯左下⻆显⽰ “usb device: not found”，则表⽰⽬标板没有正确连接到电脑上。
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Figure 2.14:连接状态指⽰

步骤 6：将选定的⽂件下载到⽬标板。
点击 “Download”按钮，所选固件⽂件将通过 USB模式下载到⽬标板的指定 flash空间。⽇志窗⼝将显⽰相应
的⽇志信息，如下所⽰。
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Figure 2.15:通过 USB模式将固件下载到 Flash中

步骤 7：复位 MCU，使新下载的程序运⾏，⽽⽆需重启 MCU（从 Burning EVK上拔下/插⼊），⽤⼾可以按照以
下任意⼀种⽅法启动并运⾏ MCU。

• 如果通过下拉菜单选择 “manual mode”，固件烧录后，⽤⼾可以点击⼯具右上⻆的 “Reset” 按钮⼿动复
位 MCU。

Figure 2.16:⼿动复位 MCU

• ⽤⼾也可以在固件烧录前通过下拉菜单选择 “auto mode”，以便在固件烧录后⾃动复位。
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Figure 2.17:⾃动复位 MCU

2.1.4 通过 “EVK”模式将固件下载到 “Flash”中

在使⽤ “EVK” 模式下载固件之前，请确保⽬标板通过 “Burning EVK” ⽅式连接到 PC，并且⽬标板的单线通信
已建⽴。
⽤⼾可以按照本章指导，通过 “EVK”模式将固件下载到⽬标板的特定 flash空间。
步骤 1：选择⽬标板的芯⽚类型，例如 8258（默认选项）。⽀持以下两种⽅法。

• ⽅法 1：使⽤下拉菜单选择芯⽚类型。
• ⽅法 2：按组合快捷键 “Ctrl+Q”切换芯⽚类型，下拉菜单将⾃动显⽰每次切换后的当前类型。

注意：
所有芯⽚类型和默认选项都可以在 “config.ini”⽂件中配置。
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Figure 2.18:选择芯⽚类型

步骤 2：选择下载模式为 “EVK”，⽀持以下两种⽅法。

• ⽅法 1：使⽤下拉菜单选择 EVK下载模式。
• ⽅法 2：按组合快捷键 “Ctrl+W”切换到 EVK下载模式。每次切换后，下拉菜单将⾃动显⽰当前下载模式。

注意：
所有的下载模式和默认选项都可在 “config.ini”⽂件中进⾏配置。
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Figure 2.19:选择下载模式为 “EVK”

步骤 3：点击 “Setting”按钮，打开设置对话窗⼝。选择 “Flash”选项。⽤⼾可以采⽤以下任意⼀种⽅法，设置
⽬标固件存储的 flash起始地址偏移量，例如 0x000000（默认选项）。

• ⽅法 1：使⽤ “Download Addr”下拉菜单选择可⽤的偏移选项。
• ⽅法 2：在 “Download Addr”的编辑框中输⼊偏移地址。

注意：
• 所有设置和默认选项都可以在 “config.ini”⽂件中配置。
• ⽤⼾还可以配置 “SRAM”/“OTP”设置选项，以便将⽬标固件下载到 SRAM或 OTP中的⽬标区域。
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Figure 2.20:打开 “Setting”对话框

步骤 4：选择要下载到⽬标板的⽬标固件⽂件。
⽤⼾可以通过 “File -> Open”或 “File -> Reopen”（如果在⼦菜单中可⽤）选择⽬标⽂件，⽂件路径将在主界⾯
的底部可⻅。

Figure 2.21:选择⽬标⽂件
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Figure 2.22:选择 bin⽂件

步骤 5：检查⽬标板和 PC之间的连接状态，确保它是正常的。

• 如果连接状态正常，主界⾯的左下⽅会显⽰ “usb device: ok”或 “evk device: ok”。
• 如果主界⾯的左下⽅显⽰ “usb device: not found”，表⽰⽬标板没有正确连接到电脑上。

Figure 2.23:检查连接状态
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步骤 6：将选定的⽂件下载到⽬标板。
通过点击 “Download” 按钮，所选的固件⽂件将通过 EVK 模式下载到⽬标板的特定 flash 空间。⽇志窗⼝将显
⽰相应的⽇志信息，如下图所⽰。

Figure 2.24:通过 “Burning EVK”模式将固件下载到 Flash中

步骤 7：复位 MCU，使新下载的程序运⾏，⽽⽆需关闭 MCU 电源。⽤⼾可以按照以下两种⽅法之⼀启动并运
⾏ MCU。

• 如果通过下拉菜单选择 “manual mode”，固件烧录后，⽤⼾可以点击⼯具右上⻆的 “Reset” 按钮⼿动复
位 MCU。
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Figure 2.25:⼿动复位 MCU

• ⽤⼾也可以在固件烧录前，通过下拉菜单选择 “auto mode”，以便在固件烧录后⾃动复位。
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Figure 2.26:⾃动复位 MCU

2.1.5 将固件下载到 “SRAM”或 “OTP”中

默认情况下，“Setting”选项设置为 “Flash”，即通过单击 “Download”按钮，⽬标固件将下载到⽬标板的 “Flash”
空间。
⽤⼾还可以将 “Setting”选项更改为 “SRAM”或 “OTP”。在这种情况下，通过点击 “Download”按钮，⽬标固件
将相应地下载到⽬标板的 “SRAM”或 “OTP”空间。
对于 TLSR8258，⽬标固件的 SRAM起始地址为 0x040000。对于其他 Telink’s SoCs，⽬标固件的 SRAM起始
地址为 0x008000。当然，⽤⼾可以根据需要在编辑框中设置其他地址。
⽬标⽂件下载成功后，⽬标板不会在 “manual mode”下⾃动运⾏新的固件，因此⽤⼾需要点击 “Reset”按钮启
动程序。⽤⼾还可以在下载前通过下拉菜单选择 “auto mode”，以启⽤ MCU⾃动复位。
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Figure 2.27:通过 “auto mode”将固件下载到 “SRAM”

如果⽬标板⽀持 OTP功能，⽤⼾可以将固件下载到 “OTP”中。详细信息请参阅第 5章功能⽀持列表。

2.1.6 多地址下载

有时候，需要将多个固件下载到 Flash、SRAM或 OTP的不同地址中。
例如，⽤⼾可以按照以下步骤将 “Telink.bin”下载到 Flash的地址 “0x000000”和 “0x005000”中。
步骤 1：选择⽬标内存空间（如 Flash）来存储要下载的固件。

AN-18101201-C6 36 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

Figure 2.28:选择⽬标空间

步骤 2：点击 “Tool -> Multi-address download”或按快捷键 “Ctrl+P”，打开 “Multi-address Download”界⾯。
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Figure 2.29:打开 “Multi-address Download”界⾯

步骤 3：点击 “Add”按钮，添加固件⽂件并设置⽬标地址。

Figure 2.30:添加固件⽂件并设置⽬标地址

步骤 4：将固件 1的路径添加到列表中，并设置起始地址的偏移量以存储此固件。
（1）⾸先，选择第⼀⾏（No.1），然后点击 “File”按钮将⽬标 bin⽂件（例如 “Telink.bin”）添加到列表中，相应
的⽬录将显⽰在 “File Path”列中。
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Figure 2.31:添加固件

Figure 2.32:显⽰ bin⽂件路径

（2）然后设置起始 Flash地址的偏移量，将该固件存储在 “Start Address(H)”列中。
为确保固件存储的⽬标区域有效，该⼯具将⾃动计算固件的⼤⼩和结束地址，然后在 “File Size(Bytes)”和 “End
Address(H)”列中显⽰计算结果。
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Figure 2.33:设置偏移地址

Figure 2.34:显⽰计算结果

步骤 5：请参阅步骤 4，将固件 2的路径添加到列表中，并设置起始地址的偏移量以存储此固件。

Figure 2.35:添加固件 2的路径
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步骤 6：单击 “Download”按钮，将添加的固件 1和固件 2下载到⽬标板的指定内存位置。

Figure 2.36: “Download”按钮

Figure 2.37:开始下载固件 1

Figure 2.38:开始下载固件 2

步骤 7：将所有固件下载到⽬标板后，点击 “Reset”按钮使程序运⾏，⽽⽆需重启⽬标板。
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Figure 2.39:复位

2.1.7 OTP启动信息下载

（1）配置 OTP时钟，以 8208芯⽚为例，otp地址 0x3ff8写⼊数据 0x060301bf。

• 功能：将 MCU数字寄存器 0x603写⼊ 0x01，⽤于配置 OTP时钟。

（2）启动代码，以 8208芯⽚为例，otp地址 0x3ff0写⼊数据 0x060298bf。

• 功能：将 MCU数字寄存器 0x602写⼊ 0x98，MCU启动代码的执⾏，程序开始跑起来。

（3）搬代码到 RAM中，以 8208芯⽚为例，otp地址 0x3ff4写⼊数据 0x0001f03f。

• 功能：MCU将 OTP中从 0地址开始的前 7936个字节的内容搬到 RAM 0地址处。
• 数据⻓度 = 0x1f0 * 16 =7936 bytes

OTP需要搬多少⼤⼩程序到 ram中，可以参照如下计算⽅法。
OTP上电第⼀次需要将 vector和 ram code段都搬到 ram中，这两个段的⼤⼩计算公式为：
ram code的 LMA的基地址 +ram code size（之所以不⽤ vector size + ram_code size来计算，是因为可能会
有对⻬因素导致⼤⼩计算的不对）
⼜因为启动信息中的⻓度信息是：实际⻓度/16。所以启动信息中的⻓度信息的通⽤的计算公式总结如下：
（（ram code的 LMA的基地址 +ram code size）（16字节对⻬））/ 16。
所以如下 lst⽂件的最终计算公式为：0x220+0xAEC，16字节对⻬后的⼤⼩为 3344; 3344/16=209(0xd1)

对应 otp地址 0x3ff4写⼊数据 0x0000d13f即可。
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Figure 2.40: lst⽂件

以 8208芯⽚为例，⽤⼾可以按照以下步骤进⾏ OTP启动信息的下载。
步骤 1：打开 BDT⼯具，选择 8208芯⽚。
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Figure 2.41:芯⽚选择

步骤 2：点击 Tool->Memory Access，输⼊ OTP地址，写⼊启动信息及其⻓度，并在 data编辑框按下回⻋键，
对应信息会烧录到 OTP地址中。
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Figure 2.42: OTP启动信息下载

2.2 擦除 Flash扇区
“Erase Flash Sector”功能⽤于以 4kB为单位从特定地址开始擦除特定 flash空间。
例如，要擦除从地址 0x040000开始的 64kB的 flash空间，⽤⼾可以按照以下步骤进⾏。
步骤 1：点击 “Setting”按钮打开设置对话框。选择 “FLASH”设置选项。
设置要擦除 flash 空间的起始地址，例如 0x040000（默认选项：0x000000），⽤⼾可以通过 “Erase Flash
Addr”下拉菜单选择偏移选项（如果可⽤），或直接在编辑框中输⼊偏移地址。
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Figure 2.43:选择起始地址

步骤 2：以 4kB为单位设置要擦除的 flash空间⼤⼩，例如 64kB（默认选项：512kB），⽤⼾可以通过 “Sector
Erase Size”下拉菜单选择⼤⼩（如果可⽤），或直接在编辑框中输⼊⼤⼩。
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Figure 2.44:设置擦除⼤⼩

步骤 3：点击 “Erase”按钮，开始擦除⽬标板的指定 flash空间。
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Figure 2.45:从 0x000000起始地址开始擦除 512kB的 flash空间

2.3 Flash去除保护
Flash被写保护之后会导致擦写以及烧录不成功，需要去除保护之后才能对 Flash进⾏相应操作。Flash去除保
护操作步骤如下。（该功能从 v5.7.0版本之后开始⽀持）
步骤 1：打开 BDT⼯具，选择芯⽚类型。
步骤 2：点击“Unlock”按钮，log中出现“Flash remove protection successfully!”代表去除保护成功。
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Figure 2.46: Flash去除保护

2.4 Cache解析
芯⽚上电搬运代码，如果即将运⾏的代码不在 cache中，则会⾃动从 Flash或 OTP中读取函数到 cache中。该
功能主要是解析 cache 搬运代码是从 flash 哪个地址取数据，以及数据内容是什么。并将解析的数据与原始数
据进⾏⽐较，来确定 cache搬运代码是否正确。该功能前提是芯⽚已下载程序并运⾏，然后通过如下步骤进⾏
解析。（该功能从 v5.7.0版本之后开始⽀持）
步骤 1：打开 BDT⼯具，选择芯⽚类型，选择芯⽚需要下载的固件。
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Figure 2.47: Bin⽂件选择

步骤 2：点击“Cache”按钮。下图标记“1”为搬运代码所在的 flash 地址。标记“2”为对应 flash 地址存储的数据。
标记“3”代表测试结果。“OK”代表搬运代码数据正确。“FAIL”代表搬运代码数据出错。
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Figure 2.48: Cache数据正确

Cache 数据出错时，“rawdata”代表 flash 地址对应的正确数据的值。“status”代表“rawdata”和 Cache 中的数
据⽐较的结果。“status”为“T”，⼆者数据⼀致。“status”为“F”，则⼆者数据不⼀致。
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Figure 2.49: Cache数据出错

2.5 Activate MCU

“与⽬标板通信失败时激活 MCU” 功能仅适⽤于 “Burning EVK” 与 “EVK” 模式下⽬标板之间的 Swire 连接，即
不⽀持 “USB”模式或 “Burning EVK”与 “EVK”模式下⽬标板之间的 USB连接。
当固件烧录失败时，请确保⽬标板通过 Swire与 “Burning EVK”连接，然后点击 “Activate”按钮启⽤此功能以
激活 MCU。
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Figure 2.50: Activate MCU

2.6 Debug

MCU 开始运⾏后，要访问内存空间（Flash/Core/Analog/OTP），⽤⼾可以直接按组合快捷键 “Ctrl+M” 或点击
“Tool -> Memory Access”，打开 “Memory Access”窗⼝，如下图所⽰。
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Figure 2.51: “Memory Access”界⾯

Table 2.1: Memory Access介绍

项⽬ 值列表 默认 快捷键

MCU类型 8366/8368/8266/8267/8269/8232/8233/8x5x 8258 Ctrl+Q

通信⽅式 EVK(Burning EVK)/USB EVK Ctrl+W

操作⽬标 Flash/Core1/Analog2/OTP Core Ctrl+E

操作⼤⼩ (单位：字节) 1/2/4/8/16 1 Ctrl+R

地址 0 0 Ctrl+A

数据 0 0 Ctrl+D

1Core包括数字寄存器和 SRAM。
2Analog指模拟寄存器。
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2.6.1 访问存储器

2.6.1.1 从内存空间读取数据

想要从特定存储空间（Flash/Core/Analog/OTP）读取数据，⽤⼾可以执⾏以下步骤：
步骤 1：在 “Memory Access”窗⼝中选择 MCU类型（如 “8258”）和与⽬标板的通信模式（如 “EVK”）。
注意：
如果选择 “USB”模式与⽬标板通信，请确保所选 MCU⽀持 USB功能且其 USB功能可⽤。

Figure 2.52:选择 MCU类型和通信模式

步骤 2：在 “Memory Access”窗⼝中选择操作⽬标（如 “CORE”）并设置操作⼤⼩（如 “16”）。
注意：

• 如果选择 “OTP”作为操作⽬标，请确保所选 MCU⽀持 “OTP”功能。
• 想要设置操作⼤⼩，⽤⼾可以通过下拉菜单选择⼤⼩（如果可⽤），或直接在编辑框中设置⼤⼩。
• 最⼤操作⼤⼩为 1MB。
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Figure 2.53:设置操作⽬标和⼤⼩

步骤 3：将⿏标移动到 “addr” 框，然后输⼊要读取的起始地址的偏移量（例如 “0x040000”）。将光标保持在
“addr”框中，通过单击 “Tab”键，⽤⼾可以从指定的内存空间读取数据。
注意：

• 每次点击 “Tab”键启动内存读取操作时，可编辑框的值将会被保存，以便下次可以通过下拉菜单直接
选择它。
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Figure 2.54:设置起始地址并开始读取

• 当读取⼤于 1kB的内存空间（如 CORE）时，读取的数据将⾃动保存到 “user”⽂件夹下名为 “read.bin”
的⽂件中。⽤⼾还可以使⽤特定的命令⾏更改⽂件名以保存读取的数据。详细信息请参阅第 2.8节命
令⾏。
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Figure 2.55:保存读取的数据

2.6.1.2 将数据写⼊内存空间

将数据写⼊特定的内存空间，⽤⼾可以执⾏以下步骤：
步骤 1：在 “Memory Access”窗⼝中选择 MCU类型（如 “8258”）和与⽬标板的通信模式（如 “EVK”）。
注意：
如果选择 “USB”模式与⽬标板通信，请确保所选 MCU⽀持 USB功能且其 USB功能可⽤。
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Figure 2.56:内存访问窗⼝

步骤 2：在 “Memory Access”窗⼝中选择操作⽬标（如 “CORE”）并设置操作⼤⼩（如 “16”）。
注意：

• 如果选择 “OTP”作为操作⽬标，请确保所选 MCU⽀持 “OTP”功能。
• 想要设置操作⼤⼩，⽤⼾可以通过下拉菜单选择⼤⼩（如果可⽤），或直接在编辑框中设置⼤⼩。
• 最⼤操作⼤⼩为 256字节。
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Figure 2.57:设置操作⼤⼩

步骤 3：将⿏标移动到 “addr”框，然后输⼊要写⼊的起始地址的偏移量（例如 “0x040000”）。
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Figure 2.58:起始地址的偏移量

注意：
当操作⽬标选择为 “CORE”时，如果设置的地址⼩于 “SRAM”的起始地址，则实际访问的⽬标存储空间为
数字寄存器；如果设置的地址⼤于 “SRAM”的起始地址，则实际访问的⽬标内存空间是 SRAM。

步骤 4：将数据写⼊指定的地址。
将⿏标移动到 “data”框，然后输⼊要写⼊的⽬标数据。将光标保持在 “data”框中，通过点击 “Enter”键，⽤⼾
可以将指定的数据写⼊指定的存储空间。
注意：
当输⼊数据时，字节之间必须⽤空格隔开，如下所⽰：
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Figure 2.59:设置数据并开始写⼊

2.6.2 操作变量列表

在查看所有全局变量之前，请确保 “.lst”⽂件和 “.bin”⽂件位于同⼀⽬录下，有可能出现两种情况，如下所⽰。
情况 1：如果只有⼀个 “.lst”⽂件和 “.bin”⽂件位于同⼀⽬录下，则会⾃动选择这个 “.lst”⽂件。

Figure 2.60:情况 1

情况 2：如果有多个 “.lst” ⽂件和 “.bin” ⽂件放在同⼀⽬录下，则⾃动选择与所选 “.bin” ⽂件同名的 “.lst” ⽂
件。

Figure 2.61:情况 2
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例如：如果选择 “Telink.bin”⽂件，将⾃动选择 “Telink.lst”⽂件。如果没有 “Telink.lst”，并且所选 “Telink.bin”
⽂件的⽬录下仅放置了⼀个 “xxx.lst”⽂件，则将会选择唯⼀的 “xxx.lst”⽂件。

2.6.2.1 更新变量列表

想要查看所有全局变量，⽤⼾可以选择 “Tdebug” ⻚⾯，将⿏标移动到变量列表，然后右键单击⿏标选择
“Refresh”或按快捷键 “F3”。每次按 “F3”，变量列表就会更新⼀次。

Figure 2.62:更新变量列表

2.6.2.2 对变量进⾏排序

根据需要，⽤⼾还可以右键单击⿏标，选择 “Sort by address” 将所有变量按地址从低到⾼排序（默认），或选
择 “Sort by name”将所有变量按变量名称的 ASCII码值从 A到 z排序（⽐较第⼀个不同的字符）。

AN-18101201-C6 63 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

Figure 2.63:按名称对变量排序

2.6.2.3 查看超过 4字节的变量

如果变量的⻓度⼤于 4 字节，通过点击 “variable list” 的 “Value” 列中的 “…”，其值将显⽰在右侧的⽇志窗⼝
中。
如果变量的⻓度⼤于 1024字节，则该变量的所有值都将保存在名为 “Read.bin”的⽂件中。
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Figure 2.64:读取⼤于 4字节的变量值

2.6.2.4 修改变量值

⻓度不超过 4字节的变量⽀持直接写⼊操作，双击 “Value”列中相应的框可以直接修改其值。
例如：要将地址 “0x41100”中变量 “adc_vref_cfg”的值修改为 “0x00000004”，⽤⼾可以执⾏以下步骤：
步骤 1：双击指定变量对应 “Value”列中的框（例如 “adc_vref_cfg”），使该框可编辑。
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Figure 2.65:双击指定的 “Value”框

步骤 2：输⼊新的变量值（例如 “0x00000025”）来替换旧的变量值（“0x00000004”）。
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Figure 2.66:修改变量值

步骤 3：按 “Enter”键将新的值写⼊指定变量的地址中。
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Figure 2.67:将数据写⼊指定地址

2.6.3 Debug MCU

在使⽤ “Run”, “Pause”, “Step” and “PC”等按钮调试 MCU之前，请确保所选 MCU⽀持此功能。有关详细信息，
请参阅第 5章功能⽀持列表。
在下⾯的⼩节中，以 MCU “8258”为例介绍该功能。

2.6.3.1 Run MCU

点击 “Pause” 或 “Step” 按钮后，⽤⼾可以通过点击 “Run” 按钮使 MCU 从当前位置继续运⾏。请点击 “PC” 按
钮查看 MCU状态，读取 PC并确保程序再次运⾏。
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Figure 2.68: Run MCU

2.6.3.2 Pause MCU

想要查看 MCU状态的详细信息，⽤⼾可以点击 “Pause”按钮暂停 MCU。点击 “Run”按钮，MCU将从当前位置
继续运⾏。
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Figure 2.69: Pause MCU

2.6.3.3 Step MCU

如果可以与⽬标板通信，⽤⼾可以点击 “Step”按钮逐步查看指令的当前位置。
“Trace MCU”和 “Step MCU”都⽀持以下两种模式。
（1）如果选择了 “Single step”模式，MCU将进⼊单步模式，在点击 “PC”或 “Step”按钮后，将实施⼀次 PC追
踪。
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Figure 2.70:在 “Single step”模式下 Step MCU

（2）如果选择 “continuous”模式，MCU将进⼊连续模式，实施连续的 PC追踪或使 MCU连续步进。
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Figure 2.71:在 “continuous”模式下 Step MCU

想要取消 “continuous”模式，⽤⼾可以将模式切换到 “Single step”模式，或者点击 “Run”/“Pause”按钮。
如果⽬标固件（bin ⽂件）和 “xxx.lst” ⽂件位于同⼀⽬录下，⽤⼾可以通过选择 “View -> interp .lst” 并点击
“PC”按钮解析 “xxx.lst”⽂件来查看更多详细信息，如下所⽰。参考第 2.6.2节操作变量列表。

Figure 2.72: “xxx.lst”⽂件
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Figure 2.73:选择 “interp.lst”
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Figure 2.74:在 “Single step”模式下选择 “interp.lst” Step MCU
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Figure 2.75:在 “continuous”模式下选择 “interp.lst” Step MCU

2.6.3.4 Trace PC

如果可以与⽬标板通信，⽤⼾可以点击 “PC”按钮查看指令的当前位置，如下所⽰：
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Figure 2.76:在 “Single step”模式下 Trace PC
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Figure 2.77:在 “Single step”模式下选择 “interp.lst” Trace PC
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Figure 2.78:将 “Single step”模式切换到 “continuous”模式
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Figure 2.79:在 “continuous”模式下选择 “interp.lst” Trace PC

2.6.3.5 Stall MCU

当没有⾜够的时间查看 MCU 的状态时，⽤⼾可以点击 “stall” 按钮暂停 MCU 并查看 MCU 的状态或更改 MCU
的配置。
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Figure 2.80: Stall MCU

注意：
在 EVK模式下，只有使⽤ “Firmware_v3.2.bin”（或更⾼版本）烧录的 EVK⽀持此功能。

2.6.3.6 Start MCU

暂停 MCU后，点击 “start”按钮启动 MCU，使 MCU从 SRAM开始运⾏。
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Figure 2.81: Start MCU

2.7 单线同步
在设置单线同步速度之前，请确保以下各项：
（1）电源正常；
（2）MCU未处于“低功耗”模式；
（3）MCU的单线功能可⽤；
（4）系统时钟正常。
当 “Burning EVK” 和⽬标板之间⽆法建⽴连接时，⽤⼾可以尝试设置 Swire（单线）同步速度来改善通信。注
意：Swire寄存器地址可能因芯⽚类型⽽异。
（1）在四个可编辑框中更改主速度和从速度，如下所⽰。注意：Swire寄存器地址可能因芯⽚类型⽽异。
（2）点击 “SWS”按钮以实现 Swire同步。
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Figure 2.82:设置 Swire同步速度

在将固件下载到⽬标板或调试 MCU之前，建议每次打开 MCU电源时，⽤⼾应执⾏⼀次 Swire同步，以检查与
⽬标板的通信是否正常。
如果与⽬标板的通信状态错误，⽤⼾可以按照第 2.5节开头提到的⽅法解决问题。

2.8 命令⾏
⽤⼾还可以使⽤命令⾏访问内存或将⽂件下载到⽬标板。在下⾯的⼩节中，以 “read core”为例。

2.8.1 单命令⾏

步骤 1：通过选择 “Tool->Cmdline Input”或按组合快捷键 “Ctrl+I”打开命令⾏输⼊窗⼝。
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Figure 2.83:打开命令⾏输⼊窗⼝

步骤 2：按如下所⽰输⼊所需的单个命令，然后按 “Enter”键。具有指定名称的⽂件将在指定位置可⽤。
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Figure 2.84:输⼊单命令⾏

2.8.2 多命令⾏

该⼯具⽀持多命令⾏操作。
所有命令都需要⽤分号隔开，如下所⽰。
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Figure 2.85:输⼊多个命令

2.9 ⽇志窗⼝
该⼯具⽀持 USB 打印功能，因此具有 USB 功能的 MCU 可以使⽤ USB 打印功能，在 PC 端的⽇志窗⼝中输出
信息。
步骤 1：点击 “View -> usb log”打开 usb⽇志窗⼝。
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Figure 2.86:打开 usb⽇志窗⼝

步骤 2：在 “usb log”模式下，所有输出的字符将以“Ascii”形式显⽰。
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Figure 2.87:显⽰输出字符

步骤 3：再次点击 “View -> usb log”退出 “usb log”模式。
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Figure 2.88:退出 “usb log”模式

2.10 帮助
点击 “Help -> Command line”，所有命令将显⽰在 “Download”或 “Tdebug”⻚⾯的⽇志窗⼝中。
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Figure 2.89:命令⾏
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Figure 2.90:显⽰所有命令

点击 “Help -> User guide”，将打开嵌⼊的 “Help”⽂档 “Telink Burning and Debugging Tool (BDT) User Guide”，
如下所⽰。
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Figure 2.91:⽤⼾指南

AN-18101201-C6 91 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

Figure 2.92:打开帮助⽂档

要获取有关 Telink的更多信息，⽤⼾可以点击 “Help -> About Telink”。
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Figure 2.93: About Telink

Figure 2.94:获取有关 Telink的信息

2.11 默认配置
在这个⼯具的根⽬录中打开 “config”⽂件夹，如下所⽰。
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Figure 2.95: “config”⽂件夹

通过修改 “config.ini”⽂件，可以更改此⼯具中的所有默认配置。下⾯是详细说明。

Figure 2.96: MCU

（1）MCU类型：8368

（2）固件路径：\bin\dut_8368_flash_v0246.bin

该固件⽤于操作 flash，例如：将指定固件下载到 flash、读/写 flash、擦除 flash 扇区，并在下载固件到 flash
或擦除 flash的某些扇区时检查 flash数据。
（3）SRAM起始地址：0x8000,例如 8258: 0x40000;

（4）单线通信：

a. 主设备的 Swire寄存器基址：0xb0

b. 主设备的 Swire时钟：0x10

c. 从设备的 Swire寄存器基址：0xb0

d. 从设备的 Swire时钟：0x10

（5）固件路径：
固件 1: \bin\dut_8368_otp_v0005.bin，⽤于操作 OTP，例如将固件下载到 OTP，读取/写⼊ OTP，在将数据
写⼊ OTP或将固件下载到 OTP期间检查 OTP数据。
固件 2: \bin\dut_8368_otp_normal_v0002.bin，⽤于将数据写⼊ OTP或将固件下载到 OTP期间检查 OTP数
据。
（6）默认：8258

Figure 2.97:通信⽅式
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（1）通信⽅式：USB

（2）默认：EVK (Burning EVK)

Figure 2.98: Objection

（1）访问 Objection：Flash

（2）默认：Core

Figure 2.99:⼤⼩

（1）读/写数据的⼤⼩：2

（2）默认：1

Figure 2.100:下载地址

（1）下载地址：0x20000

（2）默认：0

Figure 2.101:擦除地址

（1）擦除地址：0x20000

（2）默认：0

Figure 2.102:⻚⾯显⽰
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（1）⻚⾯显⽰：1 - Tdebug

（2）默认：0 - Download

Figure 2.103:按钮

（1）按钮 1的名字：example1

（2）按钮 1的属性：external executable application

（3）外部可执⾏应⽤程序的路径：E:\1_wtcdb\tcdb.exe uart -1 –u

（4）未定义按钮：Button4

按钮的属性包括三种类型：

a. external_exe：外部可执⾏应⽤程序
b. internal_exe：内部可执⾏应⽤程序，也就是这个⼯具。
c. external_file：默认情况下打开任意外部⽂件。

Figure 2.104:路径

（1）固件路径：“C:\Users\Administrator\Desktop\Telink.bin”

将此固件下载到⽬标板以更新固件，当⽂件路径过多时，可以直接删除这些路径。但是，⽆法删除第⼀条路
径。
（2）默认⽂件路径：“C:\Users\Administrator\Desktop\Telink.bin”
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3 升级固件
⽤⼾可以按照以下步骤升级 “Burning EVK”的固件。
步骤 1：点击 “Help -> Upgrade”打开 “Upgrade EVK”对话框。

Figure 3.1: “Upgrade EVK”窗⼝

步骤 2：点击 “Read FW Version”按钮检查当前固件版本。
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Figure 3.2:检查当前固件版本

步骤 3：单击 “Load…”按钮加载新固件。
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Figure 3.3:加载新固件

步骤 4：点击 “Upgrade”按钮将新固件升级到 “Burning EVK”中。注意：⽤⼾必须在使⽤ EVK之前对它进⾏重
启。
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Figure 3.4:将固件升级到 EVK中
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4 ⼯具指南
本章节主要介绍 BDT的内置⼯具，内容包括⼯具的功能及其使⽤⽅法。

4.1 BQB Tool

4.1.1 功能描述（BQB Tool）

该⼯具有两个主要的功能：

• 根据需求配置⽣成⽤于 BQB测试的固件（Flash和 SRAM两种类型的 bin⽂件），其中可配置的选项包括：
UART引脚、PA控制引脚、TX能量、内外部电容、内部供电⽅式以及校准参数的位置。另外，⽣成的固
件可以通过⼯具直接下载到 DUT中（通过 Swire的⽅式）。注意：上述 BQB测试固件为 uart两线测试程
序，串⼝通信的波特率为 115200。

• 收发包测试

4.1.2 界⾯组成及使⽤说明（BQB Tool）

该⼯具主要由固件下载界⾯和测试界⾯两个部分组成，具体如下图所⽰。

Figure 4.1: BQB⼯具固件下载界⾯
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Figure 4.2: BQB⼯具测试界⾯

4.1.2.1 芯⽚的选择

通过 BDT 主界⾯ MCU 列表来进⾏芯⽚型号的选择，选择好芯⽚之后可通过 BQB Tool 界⾯的标题栏来判断⼯
具是否⽀持对应芯⽚。

4.1.2.2 固件的保存和下载

Step1 -配置固件：固件下载界⾯“Configure”区域，Uart_TX(RX)⽤来配置 UART的 TX和 RX引脚，PA_TX(RX)
⽤来配置 PA 的 TX 和 RX 引脚，TX_Pow ⽤来配置发包的能量（default 为默认值, ⼀般为 7dBm），CAP ⽤来
配置内外部电容，Pow_mode⽤来配置芯⽚内部的供电⽅式，Cal_Pos⽤来配置校准数据的存储位置（根据实
际情况选择，测试时可选择 SRAM）。
Step2 -选择固件类型：固件下载界⾯“Operation”区域，通过单选框来选择类型，可供选择的类型包括 Flash
程序和 SRAM程序两种。
Step3 - 保存/下载固件：固件下载界⾯“Operation”区域，通过点击“Save As…”按钮来保存固件，通过点
击“Download & Run”按钮来下载固件。

4.1.2.3 收发包测试

Step1 - 连接串⼝：测试界⾯“Serial Port Setting”区域，“SerialPort”为可选择的串⼝（若列表为空，可通
过“Refresh”按钮来更新），“BaudRate”为通信的波特率（默认选⽤ 115200，与固件的串⼝通信速率保持⼀致），
串⼝配置好之后点击“Open”按钮打开串⼝。
Step2 - 配置测试模式：测试界⾯“BQB Test”区域，RFMode ⽤来选择 RF 模式，Channel ⽤来配置测试频点，
PckgType⽤来选择包的数据类型，Payload⽤来配置包的数据⻓度。
Step3 -测试：测试界⾯“BQB Test”区域，“Initialize”按钮⽤来初始化 DUT 的状态，“TX”按钮⽤来控制 DUT 发
包，“RX”按钮⽤来控制 DUT收包，“END”按钮⽤来控制 DUT停⽌收包或者发包（收包状态下点击 END按钮可
统计收包的个数）。
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4.2 Jtag Tool

4.2.1 功能描述（Jtag Tool）

该⼯具的主要功能如下：

• 安装 Jtag硬件相关的驱动
• 通过 Jtag下载/擦除固件
• 通过 Jtag读写参数
• 通过 Jtag调试

4.2.2 界⾯组成及使⽤说明（Jtag Tool）

Jtag⼯具的界⾯由两部分组成，分别是“Target”区域和“Debug”区域，具体如下图所⽰。其中“Target”区域负责
设备的连接以及 Jtag设备驱动的安装，“Debug”区域主要负责读、写、擦以及调试功能。

Figure 4.3: Jtag⼯具界⾯

4.2.2.1 Jtag设备的驱动安装

Step1 -接⼊ Jtag设备： Jtag设备如下图所⽰，通过 USB与 PC连接。
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Figure 4.4: Jtag设备

Step2 -检查设备驱动：打开设备管理器查看设备，若驱动已安装，则会被正常识别成“libusbK USB Devices”设
备，如下图所⽰。

Figure 4.5: Jtag设备驱动已安装

若驱动未正常安装，则会如下图所⽰。
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Figure 4.6: Jtag设备驱动未安装

Step3 -安装驱动： Jtag⼯具界⾯“Target”区域，点击下⽅的“Install Jtag Driver”来安装驱动。

4.2.2.2 连接调试设备

Step1 -接⼊调试设备：将调试设备通过 Jtag接⼝连接到 Jtag设备上，正常连接状态下 Jtag设备只有蓝灯常
亮。若红灯同时处于常亮状态，则先检查 Jtag 的驱动是否安装。若驱动安装正常，接着查看 Jtag 盒⼦与测试
板之间的连线是否正常。
Step2 - 连接⽬标设备：调试设备成功接⼊后，点击 Jtag ⼯具界⾯“Target”区域的“Connect Target”按钮来
连接调试设备。若 Jtag ⼯具界⾯的标题栏显⽰为“Jtag Tool – target connected”，则表⽰已经连接成功，此
时“Debug”区域的控件变为可操作状态。若连接不成功，可通过插拔⼀下 USB接⼝来解决。
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4.2.2.3 下载功能

Step1 -选择固件： BDT⼯具主界⾯，通过点击“File->Open”来选择需要下载的固件。
Step2 -设置起始地址： Jtag⼯具主界⾯“Debug”区域，在“Addr”对应的输⼊框中输⼊下载的起始地址。
Step3 -设置固件载⼊的对象： Jtag ⼯具主界⾯“Debug”区域，通过点击“FLASH”和“SRAM”两个单选框控件来
选择。
Step4 -执⾏下载： Jtag⼯具主界⾯“Debug”区域，点击“Download”按钮来执⾏下载操作。
注意：
下载到 Flash中的程序需通过点击“Restart”按钮来运⾏，⽽对于下载到 SRAM中的程序则通过点击“Run”按
钮来运⾏。

4.2.2.4 擦除功能

Step1 -设置起始地址： Jtag⼯具主界⾯“Debug”区域，在“Addr”对应的输⼊框中输⼊下载的起始地址。
Step2 -设置擦除⻓度： Jtag⼯具主界⾯“Debug”区域，在“Erase Flash”按钮下⽅“Len”对应的输⼊框中输⼊需
要擦除的⻓度。
Step3 -执⾏擦除： Jtag⼯具主界⾯“Debug”区域，点击“Erase Flash”按钮来执⾏擦除操作。

4.2.2.5 读写功能

该⼯具⽀持 Memory、Flash和 Analog三种模式的读写，其中 Memory⽅式可⽀持 byte、half-word（2 byte）、
word（4 byte）三种⽅式的读写，其他模式只⽀持按 byte来读写。
Step1 -设置读写模式： Jtag⼯具主界⾯“Debug”区域，点击“Write”按钮后⾯的下拉框来选择模式。
Step2 - 设置读写宽度： Jtag ⼯具主界⾯“Debug”区域，点击读写模式选择框下⽅的下拉框来选择读写的宽
度。
Step3 -设置读写的地址、⻓度： Jtag⼯具主界⾯“Debug”区域，在“Write”按钮下⽅“Addr”对应的输⼊框中输
⼊地址，在“Len”对应的输⼊框中输⼊⻓度。如果是写数据，还需要在“Data”对应的输⼊框中输⼊需写⼊的数
据。
Step4 -执⾏读写操作： Jtag⼯具主界⾯“Debug”区域，点击“Read”按钮来执⾏读操作，点击“Write”按钮来执
⾏写操作。

4.2.2.6 调试功能

该⼯具⽀持的调试功能包括：读状态寄存器、读变量值以及常⽤的调试操作。
Step1 -读状态寄存器： Jtag⼯具主界⾯“Debug”区域，在“Reg”对应的输⼊框中输⼊状态寄存器的名称，接着
按下回⻋键就可以查找对应的寄存器，接着通过点击下拉框来选择对应的寄存器就可以查看该寄存器的值。如
果不知道寄存器的名称，也可通过输⼊ “*”来列出所有可查看的寄存器。
Step2 -读变量值： Jtag⼯具主界⾯“Debug”区域，在“Var”对应的输⼊框中输⼊变量的名称，接着按下回⻋键
就可以查找对应的变量，接着通过点击下拉框来选择对应的变量就可以查看该变量的值。如果不知道变量的名
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称也可通过输⼊ “*” 来列出所有可查看的变量。注意：要实现该功能需要保证在 bin ⽂件⽬录下存在与之同名
的 list⽂件。
Step3 -常⽤调试操作： Jtag⼯具主界⾯“Debug”区域，点击“Stall”按钮来使设备停⽌，点击“Restart”按钮使设
备从 flash 中重新加载固件运⾏，点击“Pause”按钮来使设备程序暂停，点击“Run”按钮使设备从程序暂停处继
续运⾏，点击“Step”按钮来使设备程序单步运⾏，点击“PC”按钮来查看设备当前的 PC指针。另外，如果在 bin
⽂件⽬录下存在与之同名的 list⽂件，还可以查看对应的汇编代码，不过在使⽤该功能前还需要在“Var”对应的
输⼊框中输⼊ “*”并按下回⻋键。

4.3 TWS Tool

4.3.1 Download Tool

4.3.1.1 功能描述（Download Tool）
“Download Tool”主要⽤来烧写 bin⽂件、参数信息等到 Flash的指定地址当中。该⼯具⽀持⼀次烧录单个和多
个对象，最多⽀持⼀次烧录 4个 bin⽂件、1组 “BT Name”参数以及 1组“BT MAC”参数。

4.3.1.2 界⾯介绍
“Download Tool”的界⾯如下图所⽰，主要包括“Setting”和“Operation”两个区域。其中“Setting”区域负责设置下
载的信息，“Operation”部分负责执⾏下载操作。

Figure 4.7: TWS_Tool/Download_Tool界⾯

4.3.1.3 使⽤说明
Step1 - 设置烧录信息： Download ⼯具的主界⾯“Setting”区域，通过最左侧的单选框选择需要烧录的信息，
在“Address”对应的输⼊框中输⼊各信息写⼊的 Flash地址，在“Path/Content”对应的输⼊框中输⼊对应的信息。
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对于固件下载，通过点击对应得“Browser”按钮来加载⽂件路径。⽽对于“BT Name/MAC”，则通过对应的输⼊
框直接输⼊。“BT Name/MAC”都有⾃增的功能（每烧录完⼀组数据对应的值就会⾃增），通过右侧的单选框来
选择。另外需要注意的是“BT Name”的最⼤⻓度不得超过 25字符。
Step2 - 执⾏烧写操作： Download ⼯具的主界⾯“Operation”区域，通过点击“Download”按钮来执⾏下载操
作。

4.3.2 EQ Tool

4.3.2.1 功能描述（EQ Tool）
该⼯具的主要功能如下：

• ⽣成 EQ参数
• 进⾏在线 EQ调参（需相关协议⽀持）

4.3.2.2 界⾯组成
EQ ⼯具的界⾯由 5 个区域构成，包括图表显⽰区域、“Configure”区域、“Parameter”区域、log 输出区域以
及“Operation”区域，具体如下图所⽰。

Figure 4.8: TWS_Tool/EQ_Tool界⾯
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4.3.2.3 使⽤说明

Step1 - EQ参数调节：⾸先选择调参的模式，通过“configure”区域下的 Mode进⾏选择，⼯具默认提供三种可
选模式，分别是：“Music”模式（即 Line Out），“Speech MIC”模式（即 Line In），“Speech SPK”模式（即 Line In
to Line Out）。接着选择声道，通过“configure”区域下的 Channel进⾏选择。接着选择样本频率和 EQ调参的级
数，分别通过“configure”区域下的 FreqSmp和 Stages进⾏选择。最后配置各级参数，包括滤波器类型、Q值、
中⼼频率以及增益值，分别通过“parameter”区域下 Type、Q、Fc以及 dB来配置。
Step2 - 查看和保存 EQ 参数值：通过点击“Operation”区域中的“Get Parameter”按钮来获取参数值，通过点
击“Save as bin file”按钮可以将⽣成的参数值保存成 bin⽂件。
Step3 -保存 EQ配置：通过“Operation”区域中 Setting对应的复选框可进⾏ EQ配置的保存和还原。对于保存
操作，⾸先复选框选择“Save”，接着在弹窗中输⼊配置名称，最后点击 OK。对于还原已保存的配置，通过复选
框选择已保存的配置名称即可还原配置。
Step4 - EQ在线调参：⾸先选择在线调参的⽅式，通过“Operation”区域中的单选框控件（“USB”和“RF”）来选
择在线调参的⽅式。接着通过点击“Operation”区域中的“Download”按钮将 EQ参数下载到设备中。
注意：

EQ⼯具所⽀持的在线调参⽅式都需要有相关协议的⽀持，具体需咨询相关⼯作⼈员。

4.4 RISC-V Tool

⽀持芯⽚通过 USB实现如下功能：

• 读写寄存器
• 读写擦 flash
• 上报调试信息
• VCD功能

注意：
SDK中必须有相应的交互协议，此⼯具才能使⽤。

4.4.1 读存储器

从特定存储空间（RAM/Analog/Flash）读取数据，操作步骤如下。
Step1 -选择存储空间类型：在界⾯“Memory”区域点击下拉菜单选择类型。
Step2 -设置访问区域：“Addr”输⼊框输⼊所访问空间起始地址，并在“Size”输⼊框输⼊所需访问地址的个数。
Step3 - 读取数据：将光标保持在“Addr”框中，通过按下键盘“Tab”按键，⽤⼾可以从指定的存储空间读取数
据。
注意：

Size输⼊框中的数据为⼗六进制。写⼊“10”代表读取 16个字节数据。最多⼀次只能读取 256个字节数据。

AN-18101201-C6 109 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

Figure 4.9:读存储器

4.4.2 写存储器

在特定存储空间（RAM/Analog/Flash）写⼊数据，操作步骤如下。
Step1 -选择存储空间类型：在界⾯“Memory”区域点击下拉菜单选择类型。
Step2 -设置访问区域： “Addr”输⼊框输⼊所访问空间起始地址，并在“Size”输⼊框输⼊待写⼊数据的⻓度。
Step3 -写⼊数据： Data 框输⼊待写⼊的⽬标数据, 通过按下键盘“Enter”按键, ⽤⼾可以将指定的数据写⼊到
指定的存储空间。
注意：
写数据最多只能写⼊四个字节数据。
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Figure 4.10:写存储器

4.4.3 固件下载

将固件下载到 flash中，操作步骤如下。
Step1 -选择固件：点击“File->Import bin”，选择所需下载的固件。
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Figure 4.11:选择固件

Step2 -擦除 flash：点击“TS”按钮，其次点击“Chip_Erase”按钮擦除 flash所有数据。
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Figure 4.12:擦除 flash

Step3 -下载固件：点击“Bin_DL”按钮下载固件。
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Figure 4.13:下载固件

4.4.4 VCD功能

VCD功能操作步骤如下。
Step1 -选择 header⽂件： VCD功能区点击“Def”按钮，选择对应的 header⽂件。
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Figure 4.14:选择 header⽂件

Step2 -启动 VCD功能：点击“VCD”按钮启动。
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Figure 4.15:启动 VCD功能

Step3 -查看相关任务运⾏状态：点击“View”按钮，查看任务运⾏状态。

AN-18101201-C6 116 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

Figure 4.16:查看状态

注意：
header⽂件的定义和使⽤请咨询相关 SDK负责⼈员。

4.4.5 命令⾏说明

为⽅便调试，可输⼊对应命令执⾏相应操作。

4.4.5.1 读命令

命令格式: [28] [Type] [Address] [Size]

Type：访问空间类型，“00”代表访问数字寄存器；“01”代表访问模拟寄存器；“02”代表访问 flash。
Address：访问空间的地址，占四个字节。
Size：访问地址的个数，占 4个字节。
⽰例：读取数字寄存器 0x140280地址⼀个字节数据。

AN-18101201-C6 117 Ver1.5.0



Te
lin
k S
em
ico
nd
uc
to
r

Telink Burning and Debugging Tool (BDT)⽤⼾指南

命令：28 00 00140280 000001

Figure 4.17:读命令

4.4.5.2 写命令

命令格式 [2a] [Type] [Address] [Data1] [Data2]……[DataN]

Type：访问空间类型，“00”代表访问数字寄存器；“01”代表访问模拟寄存器；“02”代表访问 flash。
Address：访问空间的地址，占四个字节。
DataN：待写⼊的数据。
⽰例：flash 0x1000地址写⼊数据“0x1122334455”。
命令：2a 02 00001000 55 44 33 22 11
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Figure 4.18:写命令

4.4.5.3 擦 flash命令

命令格式 [2a] [03] [Address] [Size]

Address：访问空间的地址，占四个字节。
Size：擦除 flash的空间⼤⼩，占四个字节。
⽰例：flash 0x1000地址擦除 4k数据。
命令：2a 03 00001000 00001000
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Figure 4.19:擦 flash命令

⽰例：擦整⽚ flash。
命令：2a 03 00000000 00000000

4.4.5.4 保存所读数据

命令格式 [r] [String] [28] [Type] [Address] [Size] [BinPath]

r:读命令。
String：字符串，可⾃定义。
Type：访问空间类型，“00”代表访问数字寄存器；“01”代表访问模拟寄存器；“02”代表访问 flash。
Address：访问空间的地址，占四个字节。
Size：所需要读取数据⼤⼩，占四个字节。
BinPath：所读数据待保存的路径。
⽰例：从 flash 0地址读取 4k数据，并保存到 D盘。
命令：r read 0228 00000000 00001000 -d:\read.bin
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Figure 4.20:保存所读数据

4.4.6 ⽇志清除及保存

⽇志清除：点击界⾯ Clear按钮即可清除⽇志。
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Figure 4.21:清除⽇志

⽇志保存：点击界⾯ Save按钮，选择⽂件保存路径并输⼊⽂件名即可。
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Figure 4.22:保存⽇志

4.5 EMI Tool

4.5.1 功能描述（EMI Tool）

该⼯具有两个主要的功能：

• 配置和下载测试固件。
• 进⾏ EMI测试。
• 进⾏⾮信令测试。
• 进⾏ RF电流测试。

4.5.2 界⾯组成及使⽤说明（BQB Tool）

该⼯具主要由固件配置下载界⾯、EMI测试界⾯、⾮信令测试界⾯以及 RF电流测试界⾯四个部分组成，具体如
下图所⽰。
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Figure 4.23: EMI⼯具固件配置下载界⾯
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Figure 4.24: EMI⼯具 EMI测试界⾯
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Figure 4.25: EMI⼯具⾮信令测试界⾯
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Figure 4.26: EMI⼯具 RF电流测试界⾯

4.5.2.1 芯⽚的选择

通过 BDT主界⾯ MCU列表来进⾏芯⽚型号的选择。

4.5.2.2 固件的保存和下载

Step1 -配置固件：固件下载界⾯“Configure”区域，“Cap. Select”⽤来配置内外部电容，“Power Mode”⽤来配
置芯⽚内部的供电⽅式，“Calib. Pos.”⽤来配置校准数据的存储位置（根据实际情况选择）。如果使⽤“Swire
Through USB”功能，则需勾选对应的选项。
Step2 - PA配置：固件下载界⾯“PA Setting”区域，如果需要使⽤ PA功能，则勾选上“Enable”，如果使⽤ PA功
能但⼯作在 Bypass模式下，则勾选“Bypass”。除了上述操作，⽤⼾还需要将 PA操作的 binary⽂件路径输⼊到
对应的⽂本框中。PA操作相关的 binary⽂件可通过“PA Configure Tool”来⽣成，可点击“PA Configure Tool”来
打开该⼯具，⼯具的使⽤可参考对应的章节。
Step3 -选择固件类型：固件下载界⾯“Operation”区域，通过单选框来选择类型，可供选择的类型包括 Flash
程序和 SRAM程序两种。
Step4 -保存/下载固件：固件下载界⾯“Operation”区域，通过点击“Save As Binary”按钮来保存固件，通过点
击“Download”按钮来下载固件。
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4.5.2.3 EMI测试

Step1 -配置频点、功率和 RF模式： EMI 测试界⾯“Setting”区域，输⼊测试频点、选择 TX 功率（TX 测试需
要）、选择 RF模式。
Step2 - TX 测试： TX 测试包括两种 RF 类型的信号，分别是单载波信号和连续的调制信号，可通过“TX
Continue”区域的“Carrier”和“CarrierData”按钮来分别设置。另外，连续的调制信号是⽀持跳频模式的，可通过
勾选“Hop”来设置。
Step3 - RX测试：通过“RX”区域的“RX Test”按钮来控制 DUT进⼊ RX测试模式。

4.5.2.4 ⾮信令测试

Step1 -配置频点、功率和 RF模式：⾮信令测试界⾯“Setting”区域，输⼊测试频点、选择 TX功率（TX测试需
要）、选择 RF模式。
Step2 - TX测试：⾮信令测试界⾯“TX Burst”区域，通过“Pack. Count”来选择连续的发包个数（仅⽀持单次发
送 1000个包数据和不限个数两种模式），通过分别点击“PRBS9”、“0x55”以及“0x0F”来选择发送不同类型的数
据包。
Step3 - RX测试：通过“RX”区域的“RX Test”按钮来控制 DUT 进⼊ RX 测试模式，通过点击“RX Count”按钮来
查看当前的收包数，通过点击“RSSI”按钮来查看 RF信号源的功率。

4.5.2.5 RF电流测试

Step1 -下载 RF电流测试所需的固件： RF 电流测试界⾯“Current Test Firmware”区域，配置 MCU 内部供电
⽅式，点击“Download”按钮来下载电流测试的固件（每次开始时需要对 DUT进⾏下电上电操作）。
Step2 -进⾏ TX电流测试： RF 电流测试界⾯“Current Test Operation”区域，配置供电⽅式和功率以及频点，
通过点击“TX Current”按钮来进⼊ TX电流测试。
Step3 -进⾏RX电流测试：RF电流测试界⾯“Current Test Operation”区域，配置频点，通过点击“RX Current”按
钮来进⼊ RX电流测试。

4.6 PA Configure Tool

4.6.1 功能描述（PA Configure Tool）

该⼯具主要⽤来配置⽣成 PA⼯作所需的 Binary⽂件。

4.6.2 界⾯组成及使⽤说明（PA Configure Tool）

该⼯具的界⾯如下图所⽰。
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Figure 4.27: PA Configure Tool界⾯

4.6.2.1 配置⽣成 PA⼯作⽂件

Step1 -添加 PA控制的 pin脚：通过点击“Add”按钮来添加 PA⼯作所需的 pin脚。
Step2 -配置各 pin脚在不同⼯作模式下的电平：分别配置“Init”、“TX”、“RX”以及“Bypass”模式下各 pin 脚的
电平。
Step3 -⽣成 Binary⽂件：通过点击“Save As Binary”按钮来将配置保存成 binary⽂件。

4.7 EVK Offline Tool

4.7.1 功能描述（EVK Offline Tool）

该⼯具⽤来配合带有离线下载功能的 BurningEVK使⽤，主要功能包括：

• 更新 BurningEVK中⼯具固件。
• 下载⽤⼾程序到 BurningEVK中。

4.7.2 界⾯组成及使⽤说明（EVK Offline Tool）

该⼯具的界⾯包括⼯具固件界⾯和⽤⼾⼯具界⾯，具体如下图所⽰。
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Figure 4.28: EVK Offline Tool⼯具固件界⾯

Figure 4.29: EVK Offline Tool⽤⼾固件界⾯
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4.7.2.1 更新⼯具固件

Step1 -查看 BDT中的⼯具固件：通过点击“List all”按钮来查看现有的⼯具固件。
Step2 -更新固件：通过点击“Update”按钮来更新⼯具固件到 BurningEVK中。
注意：
⼯具固件界⾯默认是隐藏的，需要通过修改配置⽂件来显⽰。

4.7.2.2 下载⽤⼾固件

Step1 -添加⽤⼾固件：通过点击“Add”按钮来添加⽤⼾固件，并配置好“Chip Name”、“Bin Name”、“Destination”、
“Addr”以及“File Path”等信息。
Step2 - 下载⽤⼾固件：先将需要下载到 BurningEVK 中的固件勾选上，接着点击“Download”按钮来完成下
载。

4.8 Secure Boot Tool

该⼯具主要功能如下：

• ⽀持芯⽚配置信息以及固件下载。
• ⽀持重新使能 Debug接⼝功能。
• ⽀持读取芯⽚配置信息。

4.8.1 界⾯组成及使⽤说明

Secure Boot⼯具界⾯如下图所⽰。

Figure 4.30: Secure Boot⼯具界⾯
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4.8.1.1 Mode Selection

选择“secure boot mode”或“normal mode”任意⼀种模式。

4.8.1.2 Firmware Encryption

选择启⽤或禁⽤“Firmware Encryption”功能。

4.8.1.3 Secure Debug

选择启⽤或禁⽤“Secure Debug”功能。

4.8.1.4 Run Description Address

选择 Flash容量，相应的代码描述地址将⾃动确认。
注意：
此功能仅在“secure boot mode”模式下使⽤。

4.8.1.5 Pubkey Hash

选择待烧录的“public_key_hash.bin”⽂件。单击“Download-All”按钮后，程序会⾃动检查⽂件⻓度是否满⾜条
件。若不满⾜条件，会进⾏报错提醒。

Figure 4.31:公钥哈希⽂件错误

注意：
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此功能仅在“secure boot mode”模式下使⽤。

4.8.1.6 Root Key

输⼊框输⼊ 16 个字符的字符串或 32 个⼗六进制字符的字符串作为根密钥，同时也⽀持选择⽂本⽂件导⼊密
钥。

Figure 4.32:导⼊ Root Key⽂本

输⼊ 32个⼗六进制字符的字符串⽰例：00112233445566778899aabbccddeeff或00112233445566778899AAB-
BCCDDEEFF。
输⼊ 16个字符的字符串⽰例：tlk_key-1234abcd。
单击“Download-All”按钮后，程序会⾃动检查输⼊的字符串是否满⾜条件。若不满⾜条件，会进⾏报错提醒。
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Figure 4.33: Root Key格式错误 1

Figure 4.34: Root Key格式错误 2

注意：
Firmware Encryption或 Secure Debug功能启⽤时才需设置 Root Key。

4.8.1.7 Debug Plaintext

输⼊ 16个字符的字符串或 32个⼗六进制字符的字符串作为根密钥，同时也⽀持选择⽂本⽂件导⼊密钥。
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Figure 4.35:导⼊ Debug Plaintext⽂本

输⼊ 32个⼗六进制字符的字符串⽰例：00112233445566778899aabbccddeeff或00112233445566778899AAB-
BCCDDEEFF。
输⼊ 16个字符的字符串⽰例：tlk_key-1234abcd。
单击“Download-All”按钮后，程序会⾃动检查输⼊的字符串是否满⾜条件。若不满⾜条件，会进⾏报错提醒。
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Figure 4.36: Debug Plaintext格式错误 1

Figure 4.37: Debug Plaintext格式错误 2

注意：
Secure Debug功能启⽤时才需设置 Debug Plaintext。

4.8.1.8 Run Code

勾选复选框，选择运⾏代码 0或代码 1以及运⾏代码地址，并导⼊固件路径。
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4.8.1.9 Run Code description

勾选复选框，选择运⾏代码描述⽂件路径并导⼊。
注意：
此功能仅在“secure boot mode”模式下使⽤。

4.8.1.10 Download-All

“Setting”区域芯⽚配置信息下载到 eFuse 中。“Run Code”以及“Run Code description”区域选择的⽂件下载到
Flash中。
注意：

Secure Debug 功能启⽤，点击“Download-All”按钮，⽆论下载是否成功都会在⼯具 config\sboot\key 路
径下产⽣ Debug Key⽂件。

4.8.1.11 Download-Flash

“Run Code”以及“Run Code description”区域选择的⽂件下载到 Flash中。
注意：
已烧录过 eFuse，只需要更新固件程序，点击 Download-Flash按钮即可。

4.8.1.12 Re-enable Debug-interface

“Secure Debug”功能启⽤后，芯⽚ Debug功能会被禁⽤。点击 “Re-enable Debug-interface”按钮会弹出对话
框。选择 Yes，使⽤默认⽂件夹中的 DebugKey.txt ⽂件作为 Debug Key 去恢复 Debug 功能。选择 No，需要
⼿动导⼊⽂件作为 Debug Key去恢复 Debug功能。
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Figure 4.38:重新使能调试接⼝

4.8.1.13 Read-Info

读取芯⽚ eFuse中配置信息，不包括 Root Key以及 Debug Plaintext中的信息。
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Figure 4.39:读取信息

4.8.1.14 Save

保存界⾯配置信息，将 Root Key以及 Debug Plaintext中的信息保存到 config\sboot\key路径。

Figure 4.40: key⽂件夹路径

4.8.2 常⽤安全机制组合和⼯具的使⽤步骤说明

Secure Boot、Firmware Encryption 以及 Secure Debug 安全机制可单独使⽤并且可以⾃由组合。然⽽，在实
践中建议使⽤以下组合：

• Option 0: Secure Boot + Secure Debug

• Option 1: Firmware Encryption + Secure Debug

• Option 2: Secure Boot + Firmware Encryption + Secure Debug
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4.8.2.1 Secure Boot + Secure Debug

Step1： “Mode Selection”下拉框中选择“secure boot mode”。
Step2： “Firmware Encryption”下拉框中选择“Disable”。
Step3： “Secure Debug”下拉框中选择“Enable”。
Step4：根据芯⽚封装选择对应 Flash容量。此处默认选择“Flash：1M”。
Step5： “Run Code”区域选择运⾏代码 0或代码 1以及运⾏代码地址，并导⼊固件路径。
Step6：上⼀步骤完成后，“public_key_hash.bin”⽂件路径会⾃动导⼊到“Pubkey Hash”输⼊框中，若未成功，
则⼿动导⼊。
Step7： “Run Code description”区域导⼊运⾏代码描述⽂件路径。
Step8：在“Root Key”以及“Debug Plaintext”输⼊框中输⼊密钥。
Step9：点击“Download-ALL”按钮完成下载。

Figure 4.41: Secure Boot + Secure Debug烧录步骤

4.8.2.2 Firmware Encryption + Secure Debug

Step1： “Mode Selection”下拉框中选择“normal mode”。
Step2： “Firmware Encryption”下拉框中选择“Enable”。
Step3： “Secure Debug”下拉框中选择“Enable”。
Step4：选择固件下载地址并导⼊固件路径。
Step5：在“Root Key”以及“Debug Plaintext”输⼊框中输⼊密钥。
Step6：点击“Download-ALL”按钮完成下载。
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Figure 4.42: Firmware Encryption + Secure Debug烧录步骤

4.8.3 Secure Boot + Firmware Encryption + Secure Debug

Step1： “Mode Selection”下拉框中选择“secure boot mode”。
Step2： “Firmware Encryption”下拉框中选择“Enable”。
Step3： “Secure Debug”下拉框中选择“Enable”。
Step4：根据芯⽚封装选择对应 Flash容量。此处默认选择“Flash：1M”。
Step5： “Run Code”区域选择运⾏代码 0或代码 1以及运⾏代码地址，并导⼊固件路径。
Step6：上⼀步骤完成后，“public_key_hash.bin”⽂件路径会⾃动导⼊到“Pubkey Hash”输⼊框中，若未成功，
则⼿动导⼊。
Step7： “Run Code description”区域导⼊运⾏代码描述⽂件路径。
Step8：在“Root Key”以及“Debug Plaintext”输⼊框中输⼊密钥。
Step9：点击“Download-ALL”按钮完成下载。
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Figure 4.43: Secure Boot + Firmware Encryption + Secure Debug烧录步骤
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5 功能⽀持列表
并⾮所有 MCU类型都⽀持此⼯具的所有功能，请参考下表。

Figure 5.1:功能⽀持列表

AN-18101201-C6 143 Ver1.5.0


	修订历史
	1 简介
	1.1 功能概述

	2 操作指南
	2.1 下载固件
	2.1.1 连接硬件
	2.1.2 连接设备
	2.1.3 通过 USB 模式将固件下载到 Flash 中
	2.1.4 通过 EVK 模式将固件下载到 Flash 中
	2.1.5 将固件下载到 SRAM 或 OTP 中
	2.1.6 多地址下载
	2.1.7 OTP启动信息下载

	2.2 擦除Flash扇区
	2.3 Flash去除保护
	2.4 Cache解析
	2.5 Activate MCU
	2.6 Debug
	2.6.1 访问存储器
	2.6.1.1 从内存空间读取数据
	2.6.1.2 将数据写入内存空间

	2.6.2 操作变量列表
	2.6.2.1 更新变量列表
	2.6.2.2 对变量进行排序
	2.6.2.3 查看超过4字节的变量
	2.6.2.4 修改变量值

	2.6.3 Debug MCU
	2.6.3.1 Run MCU
	2.6.3.2 Pause MCU
	2.6.3.3 Step MCU
	2.6.3.4 Trace PC
	2.6.3.5 Stall MCU
	2.6.3.6 Start MCU


	2.7 单线同步
	2.8 命令行
	2.8.1 单命令行
	2.8.2 多命令行

	2.9 日志窗口
	2.10 帮助
	2.11 默认配置

	3 升级固件
	4 工具指南
	4.1 BQB Tool
	4.1.1 功能描述 （BQB Tool）
	4.1.2 界面组成及使用说明 （BQB Tool）
	4.1.2.1 芯片的选择
	4.1.2.2 固件的保存和下载
	4.1.2.3 收发包测试


	4.2 Jtag Tool
	4.2.1 功能描述 （Jtag Tool）
	4.2.2 界面组成及使用说明 （Jtag Tool）
	4.2.2.1 Jtag设备的驱动安装
	4.2.2.2 连接调试设备
	4.2.2.3 下载功能
	4.2.2.4 擦除功能
	4.2.2.5 读写功能
	4.2.2.6 调试功能


	4.3 TWS Tool
	4.3.1 Download Tool
	4.3.1.1 功能描述 （Download Tool）
	4.3.1.2 界面介绍
	4.3.1.3 使用说明

	4.3.2 EQ Tool
	4.3.2.1 功能描述 （EQ Tool）
	4.3.2.2 界面组成
	4.3.2.3 使用说明


	4.4 RISC-V Tool
	4.4.1 读存储器
	4.4.2 写存储器
	4.4.3 固件下载
	4.4.4 VCD功能
	4.4.5 命令行说明
	4.4.5.1 读命令
	4.4.5.2 写命令
	4.4.5.3 擦flash命令
	4.4.5.4 保存所读数据

	4.4.6 日志清除及保存

	4.5 EMI Tool
	4.5.1 功能描述 （EMI Tool）
	4.5.2 界面组成及使用说明 （BQB Tool）
	4.5.2.1 芯片的选择
	4.5.2.2 固件的保存和下载
	4.5.2.3 EMI测试
	4.5.2.4 非信令测试
	4.5.2.5 RF电流测试


	4.6 PA Configure Tool
	4.6.1 功能描述 （PA Configure Tool）
	4.6.2 界面组成及使用说明 （PA Configure Tool）
	4.6.2.1 配置生成PA工作文件


	4.7 EVK Offline Tool
	4.7.1 功能描述 （EVK Offline Tool）
	4.7.2 界面组成及使用说明 （EVK Offline Tool）
	4.7.2.1 更新工具固件
	4.7.2.2 下载用户固件


	4.8 Secure Boot Tool
	4.8.1 界面组成及使用说明
	4.8.1.1 Mode Selection
	4.8.1.2 Firmware Encryption
	4.8.1.3 Secure Debug
	4.8.1.4 Run Description Address
	4.8.1.5 Pubkey Hash
	4.8.1.6 Root Key
	4.8.1.7 Debug Plaintext
	4.8.1.8 Run Code
	4.8.1.9 Run Code description
	4.8.1.10 Download-All
	4.8.1.11 Download-Flash
	4.8.1.12 Re-enable Debug-interface
	4.8.1.13 Read-Info
	4.8.1.14 Save

	4.8.2 常用安全机制组合和工具的使用步骤说明
	4.8.2.1 Secure Boot + Secure Debug
	4.8.2.2 Firmware Encryption + Secure Debug

	4.8.3 Secure Boot + Firmware Encryption + Secure Debug


	5 功能支持列表

